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About This Manual

This manual explains how to install and use the Configuration Program on various
platforms to configure an Nways device for your network.

This manual assumes a knowledge of networking concepts.

Who Should Read This Manual

The intended user of this book is the person who will configure an Nways device
using the configuration program.

How This Manual Is Organized

This manual is divided into the following chapters:

e L ini i i i - , which
describes the installation requirements for the IBM Nways Access Integration
Services, Multiprotocol Access Services, Multiprotocol Routing Services,
Multiprotocol Switched Services, and Multiprotocol Switched Services Clients
Configuration Program and how to install the configuration program.

o [ i i i i , which describes how
to start the configuration program and some operational considerations.
. k i i i ? , Which describes how

to use the configuration program, some of its navigational features, and an
overview of the configuration process.
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Features of the Configuration Program

The Configuration Program provides a point-and click-interface for creating
configurations for the various models of devices. Doing the following tasks with this
interface is easier than using the command line interface:

Saving a configuration for later completion.

Retrieving an existing configuration from a device and either updating it or using
it as a template for configuring another device.

Using an existing configuration as a template for a different device.

Configuring multiple protocols. (You may do them in any order unless there are
inter-protocol dependencies.)

Upgrading previously-created configurations to the current format. For example,
you can upgrade a configuration that was created with a previous version of the
configuration program to the current configuration program release.

Verifying the completeness of a configuration before loading that configuration to
a device.

Using guided configuration, which displays dynamic help information for
configuration tasks.

Using context-sensitive helps for panels and parameters to get more information
as needed.

Saving configurations as backups or storing multiple versions for the same router.

Using the command line facility to automate many tasks including reading,
writing, sending, and retrieving configurations.

Creating, editing, and reading ASCII-formatted configuration files.

© Copyright IBM Corp. 1996, 1999 iX
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Library Ordering Information

Obtaining Softcopy Information

Softcopy BookManager READ library information is available for many of the IBM
2210, IBM 2212, IBM 2216, and IBM 8210 publications in the IBM Networking
Systems Softcopy Collection Kit. To place a single order for the CD-ROM, use form
number SK2T-6012. To place a single order for the 3480 cartridge, use form
number SK2T-6013.

Yearly subscriptions to the IBM Networking Systems Softcopy Collection Kit, product
number 5636-PUB, are available through your branch office representative. Order
feature code 2003 and media code 5003 for CD-ROM format. Order feature code
2004 and media code 5004 for 3480 cartridge format.

To order the CD-ROM that contains the 2210-related publications, use form number
SK2T-0404.

To order the CD-ROM that contains the 2212-related publications, use form number
SK2T-0435

To order the CD-ROM that contains the 2216- and Network Utility-related
publications, use form number SK2T-0405.

To order the CD-ROM that contains the 8210-related publications, use form number
SK2T-0425.

To order the CD-ROM that contains the MSS Client-related publications, use form
number SK2T-0429.

System Library Subscription Service

The IBM 2210 publications are available via the System Library Subscription
Service (SLSS). Use machine type 2210 and program number 5801-ARR to receive
2210 publications.

The IBM 2212 publications are available via the System Library Subscription
Service (SLSS). Use machine type 2212 and program number 5639-F73 to receive
2212 publications.

The IBM 2216 publications are available via the System Library Subscription
Service (SLSS). Use machine type 2216 and program number 5765-D47 to receive
2216 publications.

The Network Utility documentation is included in the IBM 2216 publications.

The IBM 8210 publications are available via the System Library Subscription

Service (SLSS). Use machine type 8210 and program number 5765-368 to receive
8210 publications.

© Copyright IBM Corp. 1996, 1999 Xi



Xil  Config Pgm User's Guide



Summary of Changes to This Edition

Changes to This Manual
* Minor technical changes and editorial changes have been made.

Technical changes and additions are indicated by a vertical line (]) to the left of the
change.

Changes to the Configuration Program Since the Previous Edition

The following changes were made to the configuration program since the previous
edition of this manual:

* Minor technical changes not affecting the user interface.
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Chapter 1. Obtaining and Installing the Configuration Program

This chapter describes the minimum requirements to run the IBM Nways Access
Integration Services, Multiprotocol Access Services, Multiprotocol Routing Services,
Multiprotocol Switched Services, and Multiprotocol Switched Services Clients
configuration program and the procedure for getting and installing it. It consists of

the following sections:

Important:

Before proceeding, see the README file for the latest information

about requirements and any changes to installation procedures.

Hardware and Software Requirements for the Configuration Program

frable 1 lists the minimum configuration program requirements.

Table 1. Configuration Program Requirements for Supported Operating Systems

Requirement

BM AIX

BM Operating System/2

Microsoft Windows 95 or
Windows NT

Workstation

RAM (minimum)
CD-ROM

Free Disk Space

Swapper Size

Display (minimum)

Mouse

Software

RS/6000 Model 250/410 or
higher with minimum 80-Mhz
CPU

64 MB
yes

40 MB

Additionally, you need 1 to 3
MB for each configuration
file.

N/A

Graphics (1024 x 768 x 256
colors)

3-button

AIX for RS/6000 V4.1.5 or
higher

AIXWindows
Environment/6000

Notes:

IBM-compatible PC with Intel
Pentium 166-MHz or higher
processor (see Note ﬁ

48 MB
yes

33 MB

Additionally, you need 1 to 3

MB for each configuration file.

10 MB

SVGA (1024 x 768 x 256
colors)

2-button (see Note Bod

0S/2 3.0 or higher

IBM TCP/IP 1.2.1 for OS/2 or
higher

IBM-compatible PC with Intel
Pentium 166-MHz or higher
processor (see Note ﬁ

)

48 MB
yes

37 MB

Additionally, you need 1 to 3
MB for each configuration file.

N/A

SVGA (1024 x 768 x 256
colors)

2-button (see Note Bod
)

Microsoft Windows 95 or
Windows NT

1. For AlX, the AIX Common Desktop environment (X11.dt) is required to access

Help.
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More memory and faster processors improve the program’s performance.
Functionally equivalent to a 3-button mouse.

You must make sure that TCP/IP is installed and running before using the
“Single Send or Retrieve” or “Multiple Send or Retrieve” functions. On MS
Windows platforms, the configuration program will hang if TCP/IP is not installed
and running.

The AIX version of the conversion program requires special fonts. For this program
to run correctly, you must have /usr/lib/X11/fonts/75dpi/ in your list of directories. If

you do not have this directory in your Xstation Font Path, at your Xstation, enter:
xset fp+ /usr/1ib/X11/fonts/75dpi/

This command adds the conversion program font directory to your Xstation Font
Path. Place the above line in your .profile for future use.

Note: The 2212 Access Utility does not use the conversion program.

Obtaining the Configuration Program Electronically

You can obtain the configuration program from the IBM Networking Technical
Support Home Page. Follow this procedure to download the configuration program:

1. Access the IBM Networking page at:
http://www.networking.ibm.com
2. Select Support from the Fast-Path Site-Links menu to access the Technical
Support page.
3. Select the product from the Downloads menu.
4. Select the desired code level for the configuration program that you want to

download. On the next panel, in the Files in this Package box at the bottom of

the panel, download the file you want into a temporary directory. (Consult the
README file to determine which version of the configuration program and

which file you need, and ensure that you have enough space on the hard drive.)

5. To install the configuration program, continue at t'lnstalling the Configuratior

Product Installation and Starting Information Tables

The configuration program supports multiple software products on multiple
platforms, each with their unique program names, executable file names, version
and release numbers, and so forth. The following tables list the product-specific
information that you will need when you install or start the configuration program.

For example, if you want to use the Multiprotocol Routing Services version of the
rogram on the AIX platform, download the file shown in the aixname column of
(mrsaix.lpp) from the IBM Networking page and follow the instructions at

When you are ready to start the program, you need to change to the directory
shown in the aixpath column of the same table and follow the instructions at

Table 2. AIX Product Information
Product Name |aixpath ;+ixname

Access Integration Services Version 3.4 |/usr/|pp/aisv34 |aisaix.|pp
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Table 2. AIX Product Information (continued)

Product Name aixpath aixname
Multiprotocol Access Services Version 3.4 lusr/lpp/masv34 | masaix.lpp
Multiprotocol Routing Services Version 3.4 lusr/lpp/mrsv34 mrsaix.lpp
Multiprotocol Switched Services Version 1 Release 2.2 |/usr/lpp/mssv1r22 | mssv1r22
MSS Family Clients Version 1 Release 2.2 lusr/lpp/mssv1r22 | mssclr22

[Canle 3 lists Windows-specific information. Use it if you want to use the program on

the Windows platform.

Table 3. Windows Product Information

Product Name

winfolder winprogram winname
Access Integration Services Version 3.4 AISV3.4 AISV3.4 aiswin.exe
Multiprotocol Access Services Version 3.4 MASV3.4 MASV3.4 maswin.exe
Multiprotocol Routing Services Version 3.4 MRSV3.4 MRSV3.4 mrswin.exe
Multiprotocol Switched Services Version 1 Release 2.2 Mssv1r2.2 MSSV1R2.2 MSSV1R22.exe
MSS Family Clients Version 1 Release 2.2 Msscvi1r2.2 MSSCV1R2.2 MSSCV1R22.exe

[Cahle 4 lists 0S/2-specific information. Use it if you want to use the program on the

0S/2 platform.

Table 4. OS/2 Product Information

Product Name ps2folder gs2program 0s2name

Access Integration Services Version 3.4 AIS V3.4 Config AIS V3.4 Config aisos2.cmd
Programs Program

Multiprotocol Routing Services Version 3.4 MAS V3.4 Config |MAS V3.4 Config |masos2.cmd
Programs Program

Multiprotocol Access Services Version 3.4 MRS V3.4 Config | MRS V3.4 Config |mrsos2.cmd
Programs Program

Multiprotocol Switched Services Version 1 Release 2.2 MSS V1 R2.2 MSS V1 R2.2 os2inst.cmd
Config Programs Config Program

MSS Family Clients Version 1 Release 2.2 MSSC V1 R2.2 MSSC V1 R2.2 os2inst.cmd

Config Programs

Config Program

Chapter 1. Obtaining and Installing the Configuration Program 3



Installing the Configuration Program

Once you have either obtained the appropriate CD-ROM or downloaded the
appropriate file from the IBM Networking home page, the procedure for installing
the configuration proqram depends on the operatlnq system under which the
program will run. i i u , and

linstalling on QS/2” on page 3 descrlbe the steps you take to install the

configuration program based on your operating system.

Before installing the configuration program, make sure that you have write access
to the directory in which you are installing it. The installation process writes program
files to the directory during installation and the configuration program writes
information to the directory while it is running. See the appropriate README file for
more detailed information.

Installing on AIX

1. Ensure that you are logged on as the “root” user. (The whoami command will
show root at the command prompt.) If not, enter su root .

2. If you are installing from the CD-ROM, create directory /cdrom if it does not
exist, insert the appropriate configuration program CD-ROM into the CD-ROM
drive, and mount the CD-ROM:

mount -v cdrfs -r' ' /dev/cdO® /cdrom

3. Change to the directory where the INSTALLP file (aixname—see ffanle 2 on
for the specific name) is located. On the CD-ROM it will be in the
/cdrom/config/aix directory. If you downloaded the aixname file from the IBM
Networking home page, change to the directory where the file exists.

4. Run SMIT and do either the AIX 4.1.5 or the AIX 4.2 procedure as follows:
AIX 4.1.5 Procedure:
a. Select Software Installation and Maintenance
b. Select Install and Update Software
c. Select Install/Update Selectable Software (Custom Install)
d. Select Install Software Products at Latest Level
e. Select Install New Software Products at Latest Level

AIX 4.2 Procedure:

a. Select Software Installation and Maintenance

Select Install and Update Software

Select Install and Update from Latest Available Software
Select Input device/directory for software.

Enter the fully qualified file name of the INSTALLP file (aixname—see
for the specific name) from the CD-ROM
/cdrom/config/aix  directory.

b. Press PF4 to list the software and select the installation program.
c. Select OK.

d. Select OK.
e

f

pooo

Select Done.
Select Cancel.
5. If installing from the CD-ROM, unmount the CD-ROM:
unmount /cdrom
6. Enter exit to end the root user session.
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Installing on Windows

1.

Installing on OS/2
1.
2.
3.

4.

If installing from the CD-ROM, insert the appropriate CD-ROM into the CD-ROM
drive. If autoread is on, the installation program starts and displays an
installation dialog. Otherwise, change to the /config/win directory and run setup
on the CD-ROM.

If installing after downloading the Windows installation file from the IBM
Networking page, change to the directory into which the file was downloaded

and run the winname program (see Tahle 3 on page 3 for the specific name) to
install the product.

Open an OS/2 command window.
If installing from the CD-ROM, change to the /config directory on the CD-ROM.

If installing after downloading the OS/2 installation command from the IBM
Networking page, change to the directory into which the file was downloaded.

Enter os2name (see Mable 3 an page 3 for the specific name) and follow the
prompts that display on the panel to complete the installation.

The program creates a folder that contains the Configuration Program icon. There
will also be an icon for the README files in the folder.

Chapter 1. Obtaining and Installing the Configuration Program 5
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Chapter 2. Starting the Configuration Program

This chapter describes the procedures for starting the configuration program and
how to upgrade configuration files created by earlier versions of the program. It
consists of the following sections:

Starting the Configuration Program on AIX

Before starting the configuration program, X-Windows and the common desktop
environment must be running on the workstation.

To start the configuration program:

1. Change directories to the directory that contains the configuration program, for
example:

cd /usr/lpp/ aixpath (see Ifable 2 an page 2 for the specific path)
2. Enter config & to start the program in the background.

Starting the Configuration Program with AIX NetView/6000

If you have NetView/6000 you can start the configuration program directly from the
menu bar. If the network contains routers of different types (for example, 2210 and
6611) or configuration programs of different versions and releases, you can start
any configuration program installed on the machine directly from the menu bar.

To use multiple configuration programs, make sure that each configuration program
is in a separate subdirectory from the other configuration programs and
NetView/6000.

For each configuration program that you want to start from the menu bar:

1. Create a file in the /usr/OV/registration/C subdirectory that contains the code for
the menu bar selection item.

2. Change the command statement in the file to point to the path of the desired
configuration program.

3. Save the file with a name that indicates the type, version, and release of the
configuration program you are starting.

Eigure 1 on page § is an example of the code contained in a file named MRSV34
that points to the configuration program in directory /usr/1pp/mrsv34. The C in the
line under MenuBar "Tools" represent the accelerator character for the menu
item—the underscored character in the Navigation Window menu bar’s Configure
option. This character must be in the character string directly to the left of the
action, and cannot be duplicated in another menu item.

© Copyright IBM Corp. 1996, 1999 7



/*
** (Global Tools
*/
Application "2210 MRS Configuration V3.4"
Description {
"2210 MRS Configuration V3.4"
1

/*

*x Tools

*/

MenuBar "Tools"

2210 MRS Config Tool V3.4" C f.action "cfgtool";

1
Action "cfgtool"

{
}

Command "/usr/1pp/mrsv34/config";

Figure 1. Netview/6000 Menu File MRSV34

For more information, such as how to create a sub-menu that contains all of the
configuration program menu items, refer to the IBM AlIX SystemView NetView/6000
V2R1 Programmer’s Guide, SC31-7022.

Starting the Configuration Program on Windows

To start the configuration program under Windows, select:
Start | Programs | winfolder | winprogram

(See [ahle 3 on page 3 for the specific folder name and program name.)

Starting the Configuration Program on OS/2

To start the configuration program under OS/2:

1. Locate and open the configuration program osZ2folder folder (see frable 4 od
for the specific name).
2. Double-click the configuration program os2program icon (see Table 4 on page 3
for the specific name) to start the program. The title window for the configuration
program displays.

After the Configuration Program Starts

When the program starts, it uses the options defined in the cfg.ini file. If the file
does not exist in the configuration program’s directory, the configuration program
uses default options and creates a new cfg.ini file. To change the options, select
Options from the configuration program menu bar. See m{)ﬂ

i i ions” for the options that you can change.

Upgrading/Migrating Previous-Level Configuration Files

This version of the configuration program cannot use configuration database files
with .cdb file extensions (created by earlier versions of the configuration program).
You must upgrade to the new version format (.csf file extension). If the only copy of
the existing configuration is in the router or is in a binary format (.cfg) file, before
starting the migration process you must use the version of the configuration

8 cCconfig Pgm User’s Guide



program that created the existing configuration to create configuration database

(.cdb) files, as described at 'Creating a Configuration Database File or d
Configuration Storage Filel, and then convert the files to .csf format as described at
[Canverting Configuration Database Files to Configuration Storage Format Files].

If your configuration database files were created by an earlier version of the
configuration proqram but already have .csf file extensions, go to

Creating a Configuration Database File or a Configuration Storage File

To create a configuration database file using a previous version of the configuration
program:

1. Start the previous version of the configuration program.

2. Select Configure | Read router configuration to read the existing
configuration into the configuration program.

Another way to read an existing configuration into the program is to select
Configure | Communications | Single |Retrieve .

3. Select either Configure | Save configuration or Save configuration as .

4. Save the configuration into a file with a .cdb file extension (older format) or with
a .csf file extension (newer format).

5. Continue at ECanverting Configuration Datahase Files to Configuration Staragd
Earmat Files

to convert the configuration contained in the .cdb file into a .csf

Converting Configuration Database Files to Configuration Storage

Format Files

All configuration database files (.cdb) from prior versions of the configuration
program must be converted to the configuration storage format (.csf). You can use
the configuration program to do this. It provides a dialog in which you specify which
configuration database files you want to convert. Follow these steps to use the
conversion program:

1. Start the Conversion Program.

AIX

a. Change to the directory that contains the configuration program
(/usr/ipp/aixpath) - see [Mable 2 on page 3 for the specific pathname).
b. Enter converter .

Note: See Hardware and Software Requirements for thel
Configuration Program” on page 1 for AIX font requirements

for the conversion program.

Windows 95 or Windows NT

Select:

Start | Programs | winfolder | Conversion tool

(See [Table 3 on page 3 for the specific folder name.)
0S/2
a. Locate and open the configuration program folder (os2folder - see

Table 4 on page 3 for the specific folder name).

Chapter 2. Starting the Configuration Program 9
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b. Double-click the conversion program icon (Converter Program ) to
start the conversion program.

Enter the directory that contains the database file into the Directory containing
CDB/TLV field.
Use the radio buttons to specify whether you want to convert all configurations
in the configuration database or only selected configurations. If you are
converting only selected configurations, continue with step Ell, otherwise go to
step
Select the configurations you want to convert from the Convert Configs list.
Specify the directory that will contain the new configuration files (.csf format).
Select Convert! . The program then converts the specified configurations into
separate configuration files in the Configuration Storage Directory (CSD).
Follow the procedure at

EConverting a CSE-Farmat Caonfiguration File to the
Latest Release” on page 11 to upgrade these new .csf files for compatibility with

the latest release of the configuration program.

Converting the ELAN Type Link Value File to MSS V1 R2.2 from an

Earlier Release

The ELAN Type Link Value Definition File (cfg.tlv) contains any user changes to the
standard TLV definitions. This file only needs to be migrated if the standard
definitions were changed in an earlier release. You can use the conversion program
to do this. It provides a dialog in which you specify the ELAN Type Link Value
Definition (cfg.tlv) that you want to convert. Do the following steps to use the
conversion program:

1.

2.

10 config Pgm User’s Guide

Locate the ELAN Type Link Value Definition File (cfg.tlv) for the release from
which you are migrating. This file is in the program installation directory.
Start the conversion program.

AlX

a. Change to the directory that contains the configuration program
(/usr/ipp/aixpath) - see [Tahle 2 an page 4 for the specific pathname).
b. Enter converter .

Note: See Hardware and Software Requirements for thel
Canfiguration Program” on page 1| for AIX font requirements

for the conversion program.

Windows 95 or Windows NT

Select:

Start | Programs | winfolder | Conversion tool

(See [Tahle 3 on page 3 for the specific folder name.)
0S/2
a. Locate and open the configuration program folder (os2folder - see

Mable 4 on page 3 for the specific folder name).

b. Double-click the conversion program icon (Converter Program ) to
start the conversion program.

Enter the directory that contains the TLV file into the Directory containing
CDB/TLV field.
Select the TLV file that you want to convert using the Convert Configs list.
Specify the directory that will contain the new TLYV file. This directory must be
the current release program installation directory.
Select Convert! . The program then converts the specified TLV file.




7.

Follow the procedure at ECanverting a CSE-Farmat Configuration File ta the
Latest Release’

to upgrade these new .csf files for compatibility with the latest

release of the configuration program.

Converting a CSF-Format Configuration File to the Latest Release

To convert a configuration file that is already in .csf format for use by the current
configuration program:

1.
2.

Start the latest version of the configuration program.

Select Configure | Open configuration . Select the configuration from the
Available Configurations list.

Select Open. The configuration program asks if you want to upgrade the
configuration to the current version.

Select Configure | Save configuration as to save the configuration to a new
file with a new name. Saving the configuration with a new name allows you to
keep a copy of the existing configuration file for possible future use.

Chapter 2. Starting the Configuration Program

11
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Chapter 3. Using the Configuration Program

This chapter describes the configuration program’s navigation features, explains
how to use the configuration program, and helps you to diagnose problems It
consists of the following sections:

Before Using the Configuration Program

Before using the configuration program to create configurations for your router
please read the README file that is contained in the directory in which the
configuration program is installed or on the CD-ROM. The README file contains
the most current directions for using the configuration program.

Important: The configuration program that you use must match the software that
resides on the Nways device that you are configuring. Ensure that you

have the latest software level by comparing the software you received
with the f|Ies available at the web sites named in m

Understanding the Navigation and Configuration Windows

When you first start the configuration program, it displays three windows:
The Copyright Notice window
The Navigation window
The Configuration window

Select OK in the copyright notice window to close the window. The program

displays two windows similar to those shown in Eigure 2 on page 14 and [Eigure 4
bn page 14

The window on the left is the Navigation Window and the window on the right is the
Configuration Window.

Configure the router by selecting items in the Navigation Window and then
providing the details for each selected item in the related Configuration Window.
When you have finished entering the details for an item, select a new item to

configure from the Navigation Window. ['Setting Up the Router” on page 21 shows

the typical steps to configure a new router or to change an existing configuration.

ESetting Up the Configuration Program” on page 23 shows the typical steps for

setting up the configuration program to communicate with a router.

© Copyright IBM Corp. 1996, 1999 13



Using the Navigation Window
The Navigation Window is shown in Eigure 2. It contains:
« Atitle bar
* A menu bar
* A configuration description area

» A scrollable list of folders (indicated by folder icons), which contain features and
protocols that you can configure. The folders and their contents are arranged
logically so that you perform configuration activities by starting at the top of the
window and working toward the bottom.

=2 Navigation Window

Configure  Options Hedp
Database: D:\download\config.csf
Configuration: config
Model: 2216-400

= & Network Device —
- = & Devices
—— " Slots
—— " Ports
—— " Interfaces

Dial Based Interfaces

PPP Based Interfaces

Channelized ISDN Interfaces

.
b b b O

Channel Adapters

—— " V¥irtual ATM Interfaces

— # [ LEC Interfaces
- # [ System

- = @ Protocols

# g IP

# 5 IPvb

4

Figure 2. The Initial Navigation Window

If you select any item in the Navigation Window and Guided Configuration is active
(the default setting), the program displays appropriate configuration assistance

information as you select new items. See [Using Guided Configuration” on page 14

for further information.

If an error occurs or you have not supplied required information in the current
configuration, a question mark (?) appears next to the related item. If the
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configuration information is correct, a check mark (»*) appears next to the item. For
an example of these indicators, see Ei

The Navigation Window's menu bar contains the following options:
Configure
Options
Help

The area below the menu bar is the configuration description area. It displays the
following information:

* The path and name that contains the configuration. The default path is the
directory in which you installed the configuration program, and the default
filename is config.csf .

» The filename of the current configuration (the default is config )

* The router model and, if applicable, adapter type you are configuring (the default
is set in the Options menu)

In the Navigation Window, you may display a folder’s contents either by clicking the
plus (+) icon next to the folder or by double-clicking the folder itself. You may also
choose an action to perform by selecting a folder and then pressing mouse button 2
(middle mouse button, right mouse button on a 2-button mouse) on the folder. This
displays a pop-up menu that allows you to:

* Fully expand the items in the Navigation Window.
» Expand the items in a folder.

» Display a history menu of configuration items you have selected. From the
history menu you can access any of the previously selected configuration items.
For OS/2, Windows NT, and AlX, press and hold mouse button 2 (middle mouse
button, right mouse button on a 2-button mouse) until you select the item from
the submenu displayed by the history menu item. (You do not have to hold
mouse button 2 for Windows 95.) You can invoke the history menu from any item
just as you would the pop-up menu.

» Validate a selection item in error. The Navigation Window indicates erroneous
items by displaying a large yellow question mark next to the item. The validate
function displays messages for any configuration errors or required fields that do
not have correct values based on the item selected. Using the validate function
on a folder displays validation messages for all of the items within that folder.

If you correct an error or fill in a required field and then leave the panel that
contained the error, the program removes the question mark.

Changing the Configuration Program Options
Use the Options menu to change:

* Guided configuration

* Colors

» Default model

» Default adapter

* Message prompting

* ATM address format

Notes:

1. The Multiprotocol Access Services, Multiprotocol Switched Services, and
Multiprotocol Switched Services Clients versions of the configuration program do
not contain the Default Adapter option.

2. The Access Integration Services version of the configuration program does not
contain the ATM Address Format or Default Adapter options.
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Using Guided Configuration

The configuration program contains a guided configuration facility to help you
configure a device’s features and protocols. Guided configuration consists of
elementary procedures that step you through the configuration activity for a feature
or protocol. Continuous guided configuration assistance is active by default. To
toggle it off or on, display the Navigation window and select Guided configuration
from the Options menu. If it is turned off and you want to view guided configuration
text in a help window without making it active continuously, press F1.

Notes:

1. There may be multiple ways to configure a feature or protocol. Guided
configuration is the recommended procedure.

2. Guided configuration does not keep track of where you are in a procedure. If
you follow a link to other help information from within a procedure, then when
you return to the procedure the help window displays information for the
beginning of that procedure.

Using the Configuration Window

To display the Configuration Window, select an item in the Navigation Window
(shown in

== Navigation ‘Window M= E
Lonfigue  Oglions  Help

Database: DAdownloadiconfig.csf

Configuration: config

Maodel: 2216-400

L]

- = E Protocols

- = @ P

—— ~ General

—— ~ Details

—— ~ Hedundant Gateway Interfaces
—— ~ GStatic Routes

—— ~  Filters

—— " Houte Table Filters
—— " Interfaces

- = Classical IP Over ATM
—— @ General

—— @ VCCs

—— =+ Server Redundancy

—— " Distributed ARP Server

- # [ Access Control

“] L I

Figure 3. Typical Navigation Window
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The program displays related configuration information in the Configuration Window
(shown in Eigure 4) with the name of the selected item on its title bar. It can have
the appearance of a single page of configurable items or of a notebook with several
pages of configurable items. The contents and format of the Configuration Window
depend upon the item selected in the Navigation Window.

ESI IUEII.‘ Burned-In Mdr:sj

™ Runtime generated selectar —| Hefresh
fesigned selecior [hes) Gencrate | Re-registration

List | RFC 14683 ATM addresses

£

Figure 4. The Configuration Window

To validate information that you have entered on a notebook page, right-click the
page. The program examines the fields and if it detects an error, it issues an error
message. If, at any time, the program detects a problem with a required field, it
highlights that page’s tab in color (as indicated by the Client Addr tab in Eigure 4).
Additionally, you can validate a configuration at any time by right-clicking in the
Navigation Window and then selecting the Validate option from the pop-up menu.
The program displays a list of any errors that exist, which you can correct through
the normal process of selecting items in the Navigation Window and entering new
information in the Configuration Window.

Navigating Through the Configuration Program

The configuration program features a point-and-click interface. You select items
from the Navigation Window and then fill in fields in the related pages in the
Configuration Window. The items in the Navigation Window are arranged generally
in logical top-to-bottom order so that you move down the list as you progress
through the configuration tasks, and in left-to-right order as you specify detailed
information. The configuration program provides key combinations to minimize the
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number of keystrokes needed to do tasks. To display field-specific help information
for panels in the Configuration Window, select the field and then press F1.

Using the Mouse

The mouse is the primary means for moving through the various windows in the
configuration program.

The configuration program supports the following buttons on a 3-button mouse.
(The left and middle buttons on a 3-button mouse are mapped to the left and right
mouse buttons on a 2-button mouse.)

» Left (button 1) - to select an item in a panel
* Middle (button 2) - to perform the following actions:

— In the Navigation Window

- Display a pop-up menu for a selected item in the scrollable display.

- Move through and select items in a menu.

- Validate a selection item in error. The Navigation Window indicates
erroneous items with a yellow question mark next to the item. The validate
function displays a message for each required field that does not have a
valid value and for any configuration errors.

— In the Configuration Window

- Drag-and-drop items. The program indicates that drag-and-drop is active by
changing the cursor into a hand icon. Use this function to reorder filters,
dump entries, and other configuration lists. For example, you can drag and
drop items in a list of IP addresses to reorder them and establish a new
default gateway.

Note: Some lists do not allow you to reorder items in them.
- Validate the data you have entered on a page.
* Right (button 3) is not used currently

Using the Keyboard

Some keys and key-combinations have specific functions. [[able 5 on page 19
shows the key assignments.
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Table 5. Keyboard Functions

Keys
F1 (Help)

Function
Request help (see
note).

How to Use
To obtain help for configuring a feature or
protocol:

See lUsing Guided Configuration” on page 16,

To get help on a panel:
1. Select an item in the Navigation Window, then
press F1.

To get help for a parameter, a button, or a
drop-down list:

1. Select the parameter field or button by tabbing to
the field, button, or list, then press F1.

Note: If you tab to a field or button, a colored box
highlights the item and you can then request help.
Clicking a button causes the program to do the task
indicated by the button or list.

In the help text, additional information is
hypertext-linked to the information on a particular
panel. By default, this link is highlighted in blue.

If you press F1 on a panel or a parameter without
closing a previously opened help window, the new
help text overlays the currently displayed text.

Up/Down
Arrow Keys

Left/Right
Arrow Keys

Tab and
Back-tab

Alt+C

Alt+P

Alt+H

Esc

Move vertically.

Move Horizontally

Next or previous
entry field.

Configure menu

Options menu

Help menu

Escape

Use these keys to move through lists on any panel,
including the Navigation Window or items in any of its
menu bar selection menus. To select an item, press
the Space bar.

Use these keys to move through both menu items
(after you have selected one) and their drop-down
lists in the Navigation Window. Also use them to move
through parameter fields in the Configuration Window
without affecting the existing values. To select an
item, press the Space bar.

These keys work only in the Configuration Window.
The keys move you to the various entry items in the
Configuration Windows. If there are items in a
scrollable list, such as in the Device Interfaces panel,
you will move to items that are below the scrolling
window.

Displays the Configure menu so you can select items
from it.

Displays the Options menu so you can select items
from it.

Displays the Help menu so you can select items from
it.

Clears the menus.
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Selecting Multiple Items in a List

If the configuration program displays a selection list, you can pick multiple items
from those lists. The method for selecting items depends on whether you want to
start at one point and end at another point or just choose items at random from the
list.

To select multiple individual items:
Press and hold the Ctrl key, point to each item, and then press mouse
button 1.

To select a range of items:
Select the first item in the range. Press and hold the Shift key. Select the
last item in the range and then press mouse button 1.

To deselect items:
Press and hold the Ctrl key, point to the item you want to deselect and
press mouse button 1. If you do not hold the Ctrl key, you will deselect all
previously selected items except the item just selected.

Using the Configure Menu

The Navigation Window’s Configure menu enables you to access the configuration
program’s features. The following list describes the menu choices and their usage.
The underscored character and the text in parentheses indicate the key
combination (shortcut) for the choice.

New configuration
Reset the working configuration to the default configuration for a
specific model. The program resets the Navigation Window with a
list appropriate for the selected model.

Change Model
Resets the configuration program to support the software for a
different router model.

Note: This menu item is supported only for Multiprotocol Routing
Services.

Change to High Perf Sys Card
Change the configuration of Access Integration Services models
1xx-1U and 4xx-2U to use the Release 2 High Performance System
card.

Note: If you change to the Release 2 High Performance System
card, you must select the change to high performance card
option from the Configure menu and save the resulting
configuration or your configuration will be unusable.

Open configuration (Alt+O)
Update an existing configuration or use an existing configuration as
a basis for a new configuration.

Save configuration (Alt+S)
Save the current configuration into a configuration storage file
(.csf). The physical file name under which the configuration is to be
saved is an 8.3 version of the configuration name with any invalid
file name characters replaced with underscores, and the file
extension .csf.
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Save configuration as
Save the current configuration (with a different configuration name)
into a configuration storage file (.csf). The physical file name under
which the configuration is to be saved is an 8.3 version of the new
configuration nhame with any invalid file name characters replaced
with underscores, and the file extension .csf.

Delete configuration

Remove a configuration. Note: The configuration name may not
correspond to the .csf file name. It is recommended that you use
the configuration program to delete configurations.

Create router configuration

Create a binary configuration file (.cfg) that you load into your
router.

Read router configuration
Read a binary configuration file created by the “Create router
configuration” option or obtained from the router using TFTP.

Communications

* Send or retrieve a configuration to or from a single router, restart
a single router, or query a single router’s information.

» Send or retrieve configurations to or from multiple routers or
restart multiple routers.

Note: Before using the communication features, you must
establish communications between the configuration
program and the router. See

B Router] for details.

ASCII file Create an ASCII version of a configuration. You can use this file as
documentation of a device’s configuration.

You can also read in an existing ASCII configuration file to load into
a device.

Exit (Alt+X) Leave the configuration program.

Establishing Communications Between the Configuration Program and

a Router

You must set up both the configuration program and the router before they can
communicate with one another.

If you already have a configuration loaded into the router, you need perform only

the steps described in LSemagJJp_ﬂne_Canﬁguamn_BmgLam_an_page_zﬂ
otherwise you must perform the steps in both tSetting Up the Rauter] and ESetting
p the Configuration Pragram” on page 22.

Setting Up the Router

This procedure describes how to set up the router to communicate with the
configuration program. Any of the following conditions may result in the router not
having a configuration loaded:

* You have a new router with no configuration

* You cleared the router’s configuration

* The router encountered a problem that cleared the configuration
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If any of these conditions exist, you must do the following steps to set up the router

and then do the steps at ['Setting Up the Configuration Program’l before you can

send an existing configuration to it.

1.

4.

Establish access to the router. You can do this either locally through an ASCII
terminal or remotely using Telnet, as described in your device’s setup guide. To
use Telnet, you must at least configure the IP address for the device by doing
the following steps.

Access quick configuration. For the 2210, if the router is in EZSTART mode,
enter stop to access QCONFIG. For other devices, if the device is in Config
Only> mode, enter the qc command to access quick configuration. See the
device’s setup guide for more information about quick configuration.

Establish the IP address and IP mask for the primary interface for the router,
using the following procedure.

Note: Steps Bd and apply only to the 2210.
a. Reply yes to the Configure Interfaces question.

b. Supply the interface information that is required for the LAN interface that
will communicate with the configuration program.

Reply no to the Configure Bridging question.
Reply yes to the Configure Protocols question.
Reply yes to the Configure IP question.

Reply yes to the Configure IP on this interface question for the LAN interface
that will communicate with the configuration program.

Enter the IP address at the IP Address prompt.
h. Enter the IP mask at the Address Mask prompt.

i. Reply no to the Configure IP on this interface question for the other router
interfaces.

j- Reply no to the Enable Dynamic Routing question.
k. Reply yes to the Define community with Read_Write_Trap Access question.
Enter the SNMP community name that will have Read_Write_Trap access.

I. Reply yes to the Save this configuration question.
Restart or reload the router.

-~ o o 0

When the router completes the restart sequence, it will be able to communicate with

the

configuration program.

Setting Up the Configuration Program

Note: This procedure assumes that you have already configured the IP address

and the SNMP _community and loaded them in the router, according to the
steps at ESetting Up the Router” on page 21, If that is true, you can use the
retrieve function under Communications, Single, to retrieve the information
from the router.

This procedure describes how to set up the configuration program to communicate
with the router. To do that:

1.
2.
3.
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Select the appropriate model from the New Configuration menu.
Select Interfaces in the IP folder.
In the Configuration Window:

a. Select IP Addresses next to the LAN interface with which the configuration
program will communicate.



b. Enter the IP address and Subnet Mask for this interface.

Note: These addresses must match the addresses that are configured on
the router’s interface.

c. Select Add
4. Select Communities under the SNMP folder in the Navigation Window.
5. In the Configuration Window:

a. Enter the name of the SNMP community in the Name field on the General
page. Use the SNMP community defined in step Bk-on page 22 at L'Setting

b. Select Read-write trap in the drop-down list under Access type.
c. Select Add

Note: The name and the access type must match the name and access
type that is configured on the router with which the configuration
program will communicate.

The configuration program can now communicate with the router and perform
functions such as Send configuration, Retrieve configuration, or Query router
information.

Note: Unless the version of the configuration program and the software loaded on
the router are the same, the retrieve function may fail. Use the procedure

described in Ellpgrading/Migrating Previous-1 evel Configuration Files” or

to migrate the configuration from the previous version.

Configuring a New Router
To configure a router using the configuration program:
1. Select Configure from the Navigation Window.
2. Select the model you wish to configure from the New configuration submenu.
3. Select Adapter Interfaces from the Devices folder and configure any adapters
for the router in their appropriate slots.
Notes:

a. A Ports panel exists in the AIS, MAS, and MRS versions of the configuration
program. This panel does not exist for the MSS or MSSC versions.

b. The MRS version of the configuration program displays the physical ports
first followed by the virtual ports.

In the AIS, MAS, MRS, MSS, and MSSC versions, the virtual ports can be
intermingled with the physical ports.

c. The Interfaces panel displays the interfaces sorted by slot and then port.

4. Select Interfaces from the Devices folder and configure the interfaces for the
router.

5. Expand the General folder under the Devices folder, if it is not already
expanded.

6. Select the items in the General folder and configure the parameters in each of
those items.

7. Select the items in the System folder and configure the parameters in each of
those items.

8. Select and configure the remaining folders as necessary.
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Changing an Existing Configuration

Note: While using the configuration program to change an existing configuration,
make sure that no one is updating the configuration with the router command
line interface. Any configuration data entered from the command line is lost if
you send the configuration to the router from the configuration program.

To change an existing configuration:

1. Open the configuration.

2. Use the configuration program to change the parameters you need to change.
3. Save the configuration.

4. Send the configuration to the router using the Communications menu.

Using the Command Line Facility

The Command Line facility enables you to automate configuration program
operations. You can use the config command to enter a complete set of commands
into an argument file named cfgargs, which the configuration program uses to direct
its operation, or you can use it to enter commands on the command line. (See

for an example of a cfgargs file.) To use only the config command, without
displaying the GUI interface, the last command in the file or on the command line
must be -exit. If you do not meet this requirement, the program displays the GUI
interface’s Navigation and Configuration windows. In AlX you can use the headless
command, which processes commands without invoking the GUI tool. This enables
you to use the command line facility on machines without a graphical display.

Note: You can use the config command only in a windowed operating system. You
can use the headless command in an AlX environment with or without a
windowed operating system

CFGARGS File Example

If you enter the config command, the program looks for a file named cfgargs.
shows the contents of a cfgargs file that:

* Opens a modified ASCII configuration file.
* Sends the open configuration to a router.

» Causes the current configuration to become the active configuration by rebooting
the router immediately.

» Saves the current configuration into a configuration storage file.

-displayMessages off
-storeMessages on cfgMessages.log E
-asciiRead routerOne.acf withoutlLogging
—send 1.1.1.1 private
—reboot 1.1.1.1 private
—save * routerTwo [
-exit

Figure 5. Example of CFGARGS File Contents

1. Turns off message display. If any message offers a choice, takes the default
choice.

2. Logs all messages to the specified log file.
3. Opens the specified ASCII file.
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4. Sends the configuration to a router.

5. Causes the configuration to become the active configuration by rebooting the
router immediately.

6. Stores the configuration into the directory that was specified by the previous
save command, using the specified configuration name, routerTwo.

Specifying the Config and Headless Commands

You may enter the config or the headless (AIX only) command with or without
additional commands and their arguments.

config | headless
Causes the program to search for a cfgargs file in the configuration
program directory and, if the file exists, performs the commands in
it. When the program finishes processing the commands, it ends
and deletes the file. If a cfgargs file does not exist, the program
waits for additional commands on the command line.

Note: To facilitate making future configuration changes, you may
want to prevent automatic deletion of the cfgargs file. You
can do this by using a text editor to open the cfgargs file and
keeping it open while the configuration program processes
the commands in it. As an alternative, you may want to save
a copy of the file under a different name.

config - command [args] [...]
If you specify additional commands and arguments on the
command line, the program processes them. Each command must
start with a minus sign (=) and be followed by as many additional
arguments as needed.

headless - command [args] [...]
If you specify additional commands and arguments on the
command line, the program processes them. Each command must
start with a minus sign (=) and be followed by as many additional
arguments as needed (AIX only).

If an argument, args, contains embedded blanks, you must enclose the argument in
double quotes (* 7).

Note: If you plan to enter commands on the command line, you must ensure that a
cfgargs file does not already exist in the configuration program directory. This
is necessary because if one does exist, the program processes only the
commands in it and ignores the commands you enter on the command line.

The following list describes the config and headless command-related commands
and arguments.
Notes:

1. Commands and arguments must be separated from each other by either
spaces, tabs, or new lines.

2. You can enter the commands in any case.

3. Any filename argument that does not contain the path before the physical file
name uses the current directory as the path.

-asciiRead filename [withoutLogging |
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filename Required argument. Specifies the name of an ASCII
configuration file and reads it into the configuration
program as the current configuration in memory.
Note: For AlIX, if the filename contains embedded
blanks, you must enclose it in double quotes (* ).

withoutLogging
Optional argument. Specifies that validation errors
should not be logged.

Notes:

1. The ASCII file comments are provided for information only and they are ignored
when present in an ASCII file specified by an -asciiRead command.

2. By default, the configuration program writes validation errors to an ASCII file,
which has the same name as the file you read, but with a .vlg extension.

-asciiWrite filename [withComments ]

filename Required argument. Specifies the name of the
ASCII configuration file and creates the file from the
configuration program’s current configuration in
memory.

withComments
Optional argument. Indicates whether the output file
should contain extra commentary describing the
ASCII configuration file.

Note: The ASCII file comments written by this command are provided for
information only and are ignored if they are present in an ASCII file specified
by an -asciiRead command.

-commandsFrom filename
filename Required argument. Specifies the
name of a file containing additional
commands, and reads and
processes those commands. The
-commandsFrom command may
be nested in a maximum of 10 files.
-createConfiguration filename
filename Required argument. Specifies the
name of the file being created (in
the binary format recognized by the
router) from the program'’s current
configuration in memory.
-displayMessages on | off
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Notes:

on Enables the displaying of
messages. Allows you to control the
displaying of messages.

off Disables the displaying of
messages. If a message would
have offered you a choice of
actions, the program takes the
default action.

1. The -displayMessages command can appear anywhere on the command line,
in a cfgargs file, or in any of the -commandsFrom files.

2. You may provide multiple -displayMessages commands, but the configuration
program only honors the last one.

-exit

-exitOnError

-noLogo

-open

-queryinfo

Closes the configuration program’s GUI windows and ends the
program. If you specify multiple commands, -exit must always be
the last one.

If an error occurs while processing the command line, ends the
program without starting the GUI. The errors.log file or the file
specified in the -storeMessages command identifies the source of
the error.

Suppresses displaying the configuration program'’s logo window
during startup. Because the logo window requires you to select the
OK button, specify this command to run the configuration program
in non interactive mode. This command is not necessary when
executing the headless command in AlX.

directory config

directory Required argument. Specifies the name of the
directory containing the configuration you want to
open.

config Required argument. Specifies the name of the

configuration you want to open. The command
stores the contents as the program’s current
configuration in memory. If the configuration name
contains embedded blanks, you must enclose the
name in double quotes (" ").

host name | ip address community [timeouf]

host name | ip address
Required argument. Specifies either the name of
the router, which the program can resolve into an IP
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community

timeout

-read filename

filename

address, or the router’s actual IP address. The
command retrieves a configuration summary from
the router. The program displays and logs the
summary based on the setting of the
-displayMessages and -storeMessages
commands, respectively.

Required argument. Specifies an SNMP community
that is defined on the router with read access.

Optional argument. Specifies the time (in seconds)
before the SNMP request expires. The default value
is 10.

Required argument. Specifies the name of the
router configuration file to be read, and reads it into
the program’s current configuration. The file must
be in the binary format recognized by the router,
and the release level of the configuration must
match the release level of the configuration
program.

-reboot host name | ip address community [timeout] [date] [time]

host name | ip address

community

timeout

date
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Required argument. Specifies either the name of
the router, which the program can resolve into an IP
address, or the router’s actual IP address. The
command sends a restart request to the router at
the specified date and time, based on the date and
time of the workstation on which the program is
running. The program calculates the number of
seconds between the date and time the program
processes the command and the date and time
specified in the command arguments.

Required argument. Specifies an SNMP community
that is defined on the router with read access.

Optional argument unless the date or time
arguments are specified, in which case it is
required. Specifies the length of time (in seconds)
before the SNMP request expires. The default value
is 10.

Optional argument unless the time argument is
specified, in which case it is required. Specifies the
date on which the router is to reboot. The default is
the current date. The format is dd/mm/yyyy where
dd is the 2-digit day of the month, mm is the 2-digit



-retrieve

-save

-send

time

month of the year, and yyyy is the 4-digit year. You
may enter the year as either two or four digits.

Optional argument. Specifies the time at which the
router will reboot. The default is the current time.
The format for the time is HH:MM:SS (am or pm),
or a time in 24-hour format, for example, 1800
(without the colons). The SS value, seconds, and
am or pm fields are optional.

host name | ip address community [timeouf]

host name | ip address

community

timeout

directory config

directory

config

Required argument. Specifies either the name of
the router, which the program can resolve into an IP
address, or the router’s actual IP address. The
command retrieves the configuration from the router
into the program’s current configuration in memory.

Required argument. Specifies an SNMP community
that is defined on the router with read access.

Optional argument. Specifies the length of time (in
seconds) before the SNMP request expires. The
default value is 10.

Required argument. Specifies the name of the
directory into which you want to save the current
configuration in the program’s memory. If you
specify an * instead of a name, the program uses
the most recently named configuration directory.

Note: In AIX you can only specify an * instead of a
name if you provide the -save command in a
cfgargs or -commandsFrom file. It is not
supported on the command line.

Optional argument. Specifies the name of the
configuration under which you want to save the
current configuration. The default is the current
configuration name. The physical file name under
which the configuration is to be saved is an 8.3
version of the configuration name, with any invalid
file name characters replaced with underscores and
the file extension .csf.

host name | ip address community [timeouf]
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host name | ip address

community

timeout

-sendMultiple  send list

send list

-storeMessages

Notes:

Specifies either the name of the router, which the
program can resolve into an IP address, or the
router’'s actual IP address. The command sends the
program’s current configuration in memory to the
router.

Note: If this command is issued before a valid
configuration is read using either the
-asciiRead or -open commands then the
default configuration will be sent to the
router. This default configuration will not
contain an IP address for the router so if this
configuration is activated then you will no
longer be able to communicate with the
router using IP.

Required argument. Specifies an SNMP community
that is defined on the router with read access.

Optional argument. Specifies the length of time (in
seconds) before the SNMP request expires. The
default value is 10.

Required argument. The send list contains the list
of configurations and router addresses. You
generate this list using the configuration program
menu bar to select Options » Communications -
Send Multiple , and completing the fields in the
Send Multiple window. This command sends
multiple router configurations to multiple routers.

on [filename] off

on Enables the logging of messages. If
a log file exists, the system
appends messages to it. If a log file
does not exist, the program creates
one.

filename Optional argument. Specifies the
name of the file in which to put
logged messages. The default is
cfg.log .

off Disables the logging of messages.

1. The -storeMessages command can appear anywhere on the command line,
cfgargs file, or in any of the -commandsFrom files.

2. You can provide multiple -storeMessages commands, but the configuration
program only honors the last one.
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3. If you disable -displayMessages and enable -storeMessages , the program
writes all messages to the log file.

-timedConfig  host name | ip address community [timeouf] [date] [time]

host name | ip address

community

timeout

date

time

Required argument. Specifies either the name of
the router, which the program can resolve into an IP
address, or the router’s actual IP address. The
command sends a configuration file to the router
with a request for reload at the specified date and
time, based on the date and time of the workstation
on which the program is running.

Notes:

1. This command is similar to the -send command
except that a timer is set, based on the values
provided in the date and time arguments. The
timer is not affected by reloads or power
outages. When the timer value expires, the
router loads the configuration.

2. If the date and time arguments specify
something earlier than the current date and
time, the configuration is sent to the router’s
IBD (FLASH), but the timer is not set and the
configuration will never be loaded.

3. The MSS and MSSC versions of the
configuration program do not support this
command.

Required argument. Specifies an SNMP community
that is defined on the router with read access.

Optional argument unless the date or time
arguments are specified, in which case it is
required. Specifies the length of time (in seconds)
before the SNMP request expires. The default value
is 10.

Optional argument unless the time argument is
specified, in which case it is required. Specifies the
date on which the router will reload. The default is
the current date. The format is dd/mm/yyyy where
dd is the 2-digit day of the month, mm is the 2-digit
month of the year, and yyyy is the 4-digit year. You
may enter the year as either two or four digits.

Optional argument. Specifies the time at which the
router will reload. The default is the current time.
The format for the time is HH:MM:SS (am or pm),
or a time in 24-hour format, for example, 1800
(without the colons). The SS value, seconds, and
am or pm fields are optional.
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Creating and Using ASCII Files

By default, the configuration program saves configuration files in binary format. You
can use the configuration program to create and read configuration files in ASCII
format. You can also convert configuration files from one format to the other.

An ASCII configuration file may be useful if you need to alter many configurations at
one time without having to load configurations into the graphical user interface.

Note: The ASCII configuration facility is not intended to be used to create new
configurations or to make major modifications to existing configurations.

For example, if you need to update many IP addresses throughout a network, it
may be faster to save the affected configuration files in ASCII format and then
manually (or automatically with a program) update the addresses. A configuration
file saved in ASCII format is also useful when you want to scan the configuration
online or print the configuration for review.

After updating an ASCII configuration, you can read it into the configuration program
and save the configuration in binary. You can load a configuration into a
multiprotocol device only in the binary format.

Understanding the ASCII Functions

The ASCII functions are contained in the Configure menu under the ASCII file item.

If you select ASCII file you see the following menu items:

» Create single file... creates a single ASCII configuration file.

* Read single file... reads a single ASCII configuration file into the configuration
program’s memory.

If you select Create single file... , the program displays a dialog in which you
specify the path and file name to which the program writes an ASCII file. You can
also print comments in the ASCII File from this dialog, if desired.

If you select Read single file... , the program displays a dialog in which you specify
the path and file name from which the program reads an ASCII file. You can also
prevent the configuration program from writing validation errors to a validation file in
this dialog. By default, the validation file has a .vlg file extension.

Note: For the Read single file... function to read an ASCII file successfully, you
must either:
* Create the file with the Create single file... function, or
* Create an ASCII file with the same parameter structure that the Create
single file... creates.

explains how to use the configuration command line facility to process ASCII
files.

Creating an ASCII File

The configuration program uses the current configuration to create an ASCII file.
Therefore, if you want to create an ASCII file for a particular device:

1. Configure the device. If you require an ASCII file for a device that is already
configured, use the Retrieve configuration function to obtain the configuration
and load it into the program’s memory.

2. Select Configure from the Navigation Window menu.
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3. Select ASCII file from the menu, but do not release the mouse button at this
time.

4. Move to the right and select Create single file... . The program displays a file
dialog.

5. Enter the path and file name to which the program is to write the ASCII file. If
you want to replace an ASCII file, you can select an existing file from the file
dialog.

6. Select OK.

The configuration program uses the current configuration in memory to CREATE the
ASCII file. This file will contain the configuration parameters and their current
values.

Creating an ASCII file is effectively the same as converting a configuration from its

binary form to ASCII. linterpreting an ASCII File” an page 34 explains the contents

of a sample of an ASCII file.

Adding Comments to an ASCII File

You can add comments to an ASCII file. These comments will help you to use the
ASCII file as a template for other configurations. The comments include:

* A brief description of the parameter

* The type of value

* The valid values or value ranges, if applicable

The comments are a guide to help you update the ASCII configuration file. m

Bn ASCII File as a Configuration Template” an page 40 explains using ASCII files as

configuration templates.

Reading an ASCII File

— Important
Because configuration parameters change between releases and between
PTFs, the configuration program will read only ASCII files created by the same
level configuration program. Altering the version number of an older ASCII file
or changing the version number in a valid configuration file will cause the read
function to fail. See FUnderstanding How the Configuration Program Validated
IASCII Files” on page 41| for an explanation of how the configuration program

validates an ASCII configuration.

You cannot upgrade an ASCII file from one version of the configuration
program to another version. You can only migrate binary configuration files
(csf) between releases For the procedure to mlqrate older configuration files,
see L = Z

When you read an ASCII file, the configuration program reads the file into memory
and replaces the current configuration. If you need the configuration currently in
memory, use the Save configuration or Save configuration as functions before

reading in the ASCII file. See [lUnderstanding the ASCII Functions” an page 33 for

read function restrictions.

See linterpreting an ASCII File” on page 34 for a description of the ASCII file that

can help you create your own ASCII file.
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To read an ASCII file:

1.
2.

6.

Select Configure from the Navigation Window menu.

Select ASCII file from the menu, but do not release the mouse button at this

time.

Move to the right and select Read single file... . The program displays a file

dialog.

Enter the path and file name or select a file in the dialog from which the

program should read the ASCII file.

If you want the configuration program to create an ASCII record of errors in the

configuration, select Log validation errors , which is the default. Because the

configuration program always validates configurations and shows errors, you do

not need to log validation error, but the feature is useful:

* To check the configuration and correct any problems before transmitting the
binary file to the device.

* When reading ASCII files from multiple routers so that you can determine any
validation errors when the read process completes.

Note: If you make changes in the configuration program, you can use Create
single file... to replace the erroneous ASCII file.

Select OK.

By default, the validation file has a file extension of .vilg.

After reading in the configuration, you can:
* Send the configuration file to a device using Send configuration to router
» Save the configuration using Save configuration or Save configuration as

Converting from ASCII to Binary

Multiprotocol devices require that the configurations be in binary. Using the
configuration program, you can convert an ASCII file to binary by:

1.

Reading in the ASCII file as described in FReading an ASCI| File” on page 33

and sending the configuration to the device using the Send function.

Reading in the ASCII file as described in EReading an ASCII File” on page 33

and creating a new configuration file using the Create configuration function.

Reading in the ASCII file as described in FReading an ASCI| File” on page 33

and saving the configuration using the Save configuration or Save
configuration as functions.

Converting from Binary to ASCII

If you have a binary configuration file, you can convert it by:

1.

Interpreting an AS

Reading the file, which by default has a .csf extension, into the configuration file
using Open configuration and creating the ASCII file using Create single
file....

Retrieving a configuration from a device and creating the ASCII file using
Create single file... .

Cll File

Eigure 6 an page 24 contains a sample of a portion of an ASCII file with comments.
When interpreting the ASCII file, note that:

* Header information begins with an exclamation mark (!).
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* Comments begin with an asterisk (*) in column 1. The comments contain
descriptions of the parameters and the valid values and ranges. When
necessary, the comments indicate the type of the parameters. The types are:

Multiple Segments Used for data composed of well-defined parts.
For example, a four-segment numeric address
that is used to define IP addresses and IP
address masks.

Numeric Typically used for data that may have
mathematical calculations performed on it. Data
value ranges are enforced on all numeric data

types.

String Each string must be within a certain length and
can be composed only of a specific set of
characters.

Enumerated Used for multiple-choice values. When an ASCII

file is saved with comments, the comments
explain the possible values. For example:

Enable/Disable

1 = enable, 2 = disable. Used
mainly for enabling/disabling
adapter ports and protocols.

» Configuration groups and parameters begin with a pound sign (#).

* A group of items is contained within { and }.

* Elements in a list of items are contained within { and }.

» The word "nil” signifies that the parameter currently has no value.

» All parameters appear in the file even if you did not configure them. When you

did not explicitly specify the value, the program uses the default value. If a
default value for the parameter does not exist, the program uses “nil”.

* Encrypted values are preceded by an “E.” To specify a new value to be
encrypted by the configuration program, change the “E” to a “U” and overwrite
the old value with the new value. When the configuration program reads in the
ASCII file, it will encrypt the new value.
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2210 Configuration
November 18, 1996 at 3:08:56 pm

I 'Configuration:' = 'config'
I 'Model:' = 'model 121/T'

I 'Adapter:' = 'emptySlot'

I '"Wersion:' = '13011"'

ES

'appletalk' = {

at2General = {
at2Enable : Enable Appletalk 2
value : enable or disable
at2Checksum : Checksum
value : enable or disable
at2Translation : Translate
value : enable or disable
at2FastPath : Fast path cash size
value : range from 100 to 10000
#'at2General' = {
#'at2Enable' = 'disable’
#'at2Checksum' = 'disable’
#'at2Translation' = 'disable’
#'at2FastPath' = '500'

* % X X ok X %X X X

at2Interface = {
at2InterfaceGeneral = {

value : range from 1 to 65279
value : range from 1 to 65279

at2NodeNumber : Node number
value : range from 0 to 254

at2InNFilter : Input NFilter
at20utNFilter : Output NFilter
at2InZFilter : Input ZFilter

at20utZFilter : Output ZFilter

EEE I R I R I R R R

value : enable or disable

at2Interfaces = { list of at2Interface }

at2FirstNetworkRange : Lowest number of network range

at2LastNetworkRange : Highest number of network range

at2DefaultZoneName : Default zone name
value : a string no more than 34 character(s) in length
with any ASCII character
value : 1 of the following strings: None Inclusive Exclusive
value : 1 of the following strings: None Inclusive Exclusive

value : 1 of the following strings: None Inclusive Exclusive

value : 1 of the following strings: None Inclusive Exclusive
at2Enablelnterface : Enable interface

Figure 6. Sample ASCII Configuration with Comments (Part 1 of 3)
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at2InputNetworkFilter : Input NFilter
value : 1 of the following strings: None Inclusive Exclusive
at20utputNetworkFilter : Output NFilter
value : 1 of the following strings: None Inclusive Exclusive
at2InputZoneFilter : Input ZFilter
value : 1 of the following strings: None Inclusive Exclusive
at20utputZoneFilter : Output ZFilter
value : 1 of the following strings: None Inclusive Exclusive
at2SplitHorizon : Split horizon
value : enable or disable }
at2ZoneNames = { list of at2ZoneName }
at2ZoneName = {
at2ZName : Zone name
value : a string
no less than 1 character(s) in length
and no more than 32 character(s) in length

with any ASCII character }= at2NFilters = { Tist of at2NFilter }

at2NFilter = {
at2FirstFilterNetworkRange : First network range number
value : range from 1 to 65279
at2LastFilterNetworkRange : Last network range number
value : range from 1 to 65279
at2NetworkFilterType : Filter type
value : 1 of the following strings: In Out }
at2ZFilters = { list of at2ZFilter }
at2ZFilter = {
at2FilterZoneName : Zone name
value : a string
no less than 1 character(s) in length
and no more than 30 character(s) in length
with any ASCII character
at2ZoneFilterType : Filter type
value : 1 of the following strings: In Out } }

#'at2Interfaces' = {

#'at2Interface' = {

#'at2InterfaceGeneral' = {
#'at2FirstNetworkRange' = nil
#'at2LastNetworkRange' = nil
#'at2NodeNumber' = '0'
#'at2DefaultZoneName' = nil
#'at2InNFilter' = 'None'
#'at20utNFilter' = 'None'
#'at2InZFilter' = 'None'
#'at20utZFilter' = 'None'
#'at2Enablelnterface' = 'disable’
#'at2InputNetworkFilter' = 'None'
#'at20utputNetworkFilter' = 'None'
#'at2InputZoneFilter' = 'None'
#'at20utputZoneFilter' = 'None'
#'at2SplitHorizon' = 'enable'

}

#'at2ZoneNames' = { }

#'at2NFilters' { }

#'at2ZFilters' { }

#'at2Interface' = {

#'at2InterfaceGeneral' = {
#'at2FirstNetworkRange' = nil
#'at2LastNetworkRange' = nil

Figure 6. Sample ASCII Configuration with Comments (Part 2 of 3)
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#'at2NodeNumber' = '0'
#'at2DefaultZoneName' = nil
#'at2InNFilter' = 'None'
#'at20utNFilter' = 'None'
#'at2InZFilter' = 'None'
#'at20utZFilter' = 'None'
#'at2Enablelnterface' = 'disable’
#'at2InputNetworkFilter' = 'None'
#'at20utputNetworkFilter' = 'None'
#'at2InputZoneFilter' = 'None'
#'at20utputZoneFilter' = 'None' #'at2SplitHorizon' = 'enable'
}
#'at2ZoneNames' = { }
#'at2NFilters' { }
#'at2ZFilters' { 1}
#'at2Interface' = {
#'at2InterfaceGeneral' = {
#'at2FirstNetworkRange' = nil
#'at2LastNetworkRange' = nil
#'at2NodeNumber' = '0'
#'at2DefaultZoneName' = nil
#'at2InNFilter' = 'None'
#'at20utNFilter' = 'None'
#'at2InZFilter' = 'None'
#'at20utZFilter' = 'None'
#'at2Enablelnterface' = 'disable’
#'at2InputNetworkFilter' = 'None'

#'at20utputNetworkFilter' = 'None'
#'at2InputZoneFilter' = 'None'
#'at20utputZoneFilter' = 'None'

#'at2SplitHorizon' = 'enable'
}
#'at2ZoneNames' = { }
#'at2NFilters' { 1}
#'at2ZFilters' { 1}

Figure 6. Sample ASCII Configuration with Comments (Part 3 of 3)

Processing ASCII Files Using the Command Line Facility
Besides the functions described in tUnderstanding the ASCII Functions” on page 32,

the configuration program command line facility also supports the following
functions:

Convert Binary to ASCII
Enables you to select one or more binary formatted configuration files from
a configuration storage file (.csf), create ASCII formatted files, and save
them to the hard drive.

Convert ASCII to Binary
Enables you to select one or more ASCII formatted configuration files from
the hard drive, create binary formatted configuration files, and save them to
a configuration storage file (.csf).

The following sections describe using the configuration program command line

facility to process ASCII files. Examples are included to help you build cfgargs files
SO you can run certain processes in batch mode.
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Creating an ASCII File
Use the asciiWrite command to create an ASCII file. If you want to create an ASCII
file for a specific device, retrieve the configuration from the device before the write
command in the cfgargs file. The following example creates an ASCII file of the
configuration for device CON656A with comments and then exits the configuration
program:
-displayMessages off
-storeMessages on cfgCmds.Tog

-retrieve CON656A myread

-asciiWrite d:\asccfgs\con656a.acf withComments
-exit

Reading an ASCII File

Use the asciiRead command to read an ASCII file into the configuration program’s
memory. The following example reads the ASCII file named rtr656b.acf in directory
asccfgs:

-dispTlayMessages off

-storeMessages on cfgCmds.log

-asciiRead d:\asccfgs\rtr656b.acf
-exit

Note: Validation errors are logged to file rtr656b.vlg.

Converting from ASCII to Binary
Use the createConfiguration command to convert an ASCII file to a binary file that
you can use as backup for a device’s configuration. The following example reads in
an ASCII file, transmits it to a device, and then creates a binary configuration file for
backup.
-displayMessages off
-storeMessages on cfgCmds.log

-asciiRead d:\asccfgs\mss656c.acf

-send mss656c mywrite

-createConfiguration d:\bincfgs\mss656c.cfg
-exit

Converting a Retrieved File to ASCII
There may be times when you need to review the current configuration, for
example, debugging or planning for an upgrade. The next example retrieves the
configuration from device RTR656D and converts the configuration to ASCII for later
use.
-displayMessages off
-storeMessages on cfgCmds.log

-retrieve rtr656d readit

-asciiWrite d:\asccfgs\rtr656d.acf
-exit

Using the ASCII File Functions with Multiple Devices

There may be times when you need to either create ASCII versions of
configurations from multiple routers or convert multiple ASCII files to binary to
transmit to various devices. The following sections outline a method to achieve
those goals using the command line facility.

Creating Multiple ASCII Files:  This following example assumes that you have
just received five devices that were pre-configured. It illustrates a way to create
documentation of the configuration for those devices.
-displayMessages off
-storeMessages on cfgCmds.log

-retrieve rtr656a reada

-asciiWrite d:\asccfgs\rtr656a.acf

-retrieve rtr656b readb
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-asciilWrite d:\asccfgs\rtr656b.acf
-retrieve rtr656c¢c readc
-asciilWrite d:\asccfgs\rtr656c.acf
-retrieve rtr656d readit
-asciiWrite d:\asccfgs\rtr656d.acf
-retrieve rtr656e readit
-asciilWrite d:\asccfgs\rtr656e.acf
-exit

Reading Multiple ASCII Files: ~ The following example assumes that you need to
reload five devices with configurations and you have valid ASCII files. You have
already set up the devices to communicate with the configuration program on each
of the devices. Each device has a unique configuration and you do not need the
binary configuration saved.
-dispTlayMessages off
-storeMessages on cfgCmds.Tog

-asciiRead d:\asccfgs\rtr656f.acf

-send mss656f mywritef

-asciiRead d:\asccfgs\rtr656g.acf

-send mss656g mywriteg

-asciiRead d:\asccfgs\rtr656h.acf

-send mss656h mywriteh

-asciiRead d:\asccfgs\rtr656i.acf

-send mss6561i mywritei

-asciiRead d:\asccfgs\rtr656j.acf

-send mss656j mywrite]
-exit

Using an ASCII File as a Configuration Template

The ability to create and read ASCII files can assist you in automating the process
of creating or updating a large number of device configurations. The following
procedure outlines a method that you can use to perform a mass update.

1. Create a file that contains the new information for the devices you are
configuring. You can use a full or partial template. Make sure that any interfaces
or adapters specified match the models and adapters specified in the header.

2. Create a program to read the device file and a configuration template file.

3. Create a copy of the template file, update the new copy with the device
information, and save the file with a name that would help you to identify the
device for later transmittal.

4. Locate a device in your network that contains a configuration that closely
matches the target devices. Ideally, the only things you should need to change
are items like IP addresses, MAC addresses, dial circuit numbers, or other such
items. The devices should support and use the same filters and protocols and
have the same interfaces.

5. From the device you located in step E, retrieve the device configuration using
Retrieve configuration . You can retrieve the configuration with the command
line facility of the configuration program.

6. Create an ASCII file of the configuration.
7. Create the new conEIgurations using the ASCII file you created in step E, the file
you created in step W, and the program you created in step B

After you create the new configurations, you can use the configuration program to
read the resulting ASCII files, save them as binary files, if needed, and then send

the files to the appropriate devices. EReading Multiple ASCII Files!l contains more

information about how the command line facility can help you automate this task.
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Understanding How the Configuration Program Validates ASCII Files

The configuration program performs the following actions while reading the ASCII
files:

 If there is an adapter specified in the header, the program compares that value
with the adapter type in the Devices group of the configuration file.

» If there is a model specified in the header, the program:

1. Checks to see that the defined interfaces match the model capabilities. For
example, a 2210 Model 12T cannot have an Ethernet interface. In this case,
the program discontinues reading the configuration and logs an error.

2. Verifies that the number of interfaces is correct for the device configuration
identified in the header.

If there are too many interfaces defined, the program discontinues reading
the configuration because it cannot determine which definitions are correct
and logs an error.

If there are too few interfaces, the program fills in defaults for the undefined
interfaces. For example, if the device has two WAN ports and you supply
values for one, the program uses defaults for the missing interface after the
configured interface.

Note: Undefined interfaces must be the last interfaces in the interface list.
For example, if you define interfaces 0, 2, and 3, the configuration
program will not use defaults for the missing interface. In this case,
you must define the consecutive interfaces 0, 1, 2, and 3 for the
program to provide defaults for the missing interface. For interface 1,
you must provide a default interface.

» Compares the number of device interfaces to the number of elements in the
interface protocol list.

If there are fewer elements in the interface protocol list than the number of
device interfaces, the program fills the list with default protocols for the remaining
interfaces.

If there are more elements in the interface protocol list, than the number of
device interfaces, the program discontinues reading the configuration and logs an
error.

Diagnosing Configuration Program Problems

If you experience problems with the configuration program, locate the symptom in
able 6 that most closely describes the problem and perform the actions described
in the Recommended Actions column.

Table 6. Problem Symptoms

Symptom Recommended Actions

Exit with error 34 message | This message indicates that there is not enough space in the
when attempting to start /tmp directory for the program to start. To avoid this problem,
the configuration program | either delete unnecessary files in the directory or use SMIT to

in AIX allocate more space to it.
Cannot read or make Revert to the original initialization files by reinstalling the
selections from a panel program.

The configuration program | Stop other applications to see if that enables the program to
is running slowly or is hung | operate normally. If it does not, revert to the original initialization
files by reinstalling the program.
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Table 6. Problem Symptoms (continued)

Symptom Recommended Actions

Internal Execution Error or | Do the following:

Run Time Error (indicated |1. Record the version of the configuration program that you are
by an error message in a using and any problem-related error messages.

pop-up window) 2. Copy the following files in the configuration program’s
directory to a safe place:

* The walkback.log file

* The binary router configuration file (.cfg) that you were
creating
* The configuration storage file (.csf) that you were

creating
3. Contact IBM Customer Service and provide the saved files.

Removing the Configuration Program

Before removing the configuration program, you must save all of the configuration
files with a .csf extension into the configuration program’s directory, if the
configurations are still required for your network. Use either the Save configuration
or Save configuration as choices from the Configuration menu (described in

FSing fhe Configure Menm >0).

To remove the configuration program:
1. Copy the configurations to another directory if necessary.

2. For Windows, use the Add/Remove Programs option from the Control Panel to
uninstall the program. For OS/2, use either the del or erase command to delete
the files in the configuration program’s directory, then delete the folder. For AlX,
use SMIT to uninstall the program.
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